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Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any
way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or
"ZKTeco").

ZK is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned by
their respective owners.

This manual contains information on the operation and maintenance of the ZKTeco equipment. The
copyright in all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and is
the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any third
party without express written permission of ZKTeco.

The contents of this manual must be read as a whole before starting the operation and maintenance of
the supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please
contact ZKTeco before starting the operation and maintenance of the said equipment.

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and
maintenance personnel are fully familiar with the design and that the said personnel have received
thorough training in operating and maintaining the machine/unit/equipment. It is further essential for
the safe operation of the machine/unit/equipment that personnel has read, understood and followed the
safety instructions contained in the manual.

In case of any conflict between terms and conditions of this manual and the contract specifications,
drawings, instruction sheets or any other contract-related documents, the contract
conditions/documents shall prevail. The contract specific conditions/documents shall apply in priority.

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information
contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty
of any kind, including, without limitation, any warranty of design, merchantability or fitness for a
particular purpose.

ZKTeco does not assume responsibility for any errors or omissions in the information or documents which
are referenced by or linked to this manual. The entire risk as to the results and performance obtained from
using the information is assumed by the user.

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect,
special, or exemplary damages, including, without limitation, loss of business, loss of profits, business
interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or
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relating to the use of the information contained in or referenced by this manual, even if ZKTeco has been
advised of the possibility of such damages.

This manual and the information contained therein may include technical, other inaccuracies or
typographical errors. ZKTeco periodically changes the information herein which will be incorporated into
new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify the
information contained in the manual from time to time in the form of circulars, letters, notes, etc. for
better operation and safety of the machine/unit/equipment. The said additions or amendments are
meant for improvement /better operations of the machine/unit/equipment and such amendments shall
not give any right to claim any compensation or damages under any circumstances.

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any
non-compliance of the instructions contained in this manual (i) in case of operation of the
machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment in
conditions different from the prescribed conditions of the manual.

The product will be updated from time to time without prior notice. The latest operation procedures and
relevant documents are available on http://www.zkteco.com

If there is any issue related to the product, please contact us.

ZKTeco Industrial Park, No. 32, Industrial Road,
Tangxia Town, Dongguan, China.

+86 769 - 82109991

+86 755 - 89602394

For business-related queries, please write to us at sales@zkteco.com.

To know more about our global branches, visit www.zkteco.com.
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ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein)
readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition
Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and
Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security
solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art
700,000 square foot 1SO9001-certified manufacturing facility, we control manufacturing, product design,
component assembly, and logistics/shipping, all under one roof.

The founders of ZKTeco have been determined for independent research and development of biometric
verification procedures and the productization of biometric verification SDK, which was initially widely
applied in PC security and identity authentication fields. With the continuous enhancement of the
development and plenty of market applications, the team has gradually constructed an identity
authentication ecosystem and smart security ecosystem, which are based on biometric verification
techniques. With years of experience in the industrialization of biometric verifications, ZKTeco was
officially established in 2007 and now has been one of the globally leading enterprises in the biometric
verification industry owning various patents and being selected as the National High-tech Enterprise for 6
consecutive years. Its products are protected by intellectual property rights.

This manual introduces the operations of the C2-260 Access Control Panel.

All figures displayed are for illustration purposes only. Figures in this manual may not be exactly
consistent with the actual products.
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Document Conventions

Conventions used in this manual are listed below:

GUI Conventions

Convention Description
Bold font Used to identify software interface names e.g. OK, Confirm, Cancel
S Multi-level menus are separated by these brackets. For example, File > Create >

Folder.

Convention Description
<> Button or key names for devices. For example, press <OK>
[ Window names, menu items, data table, and field names are inside square
brackets. For example, pop up the [New User] window
/ Multi-level menus are separated by forwarding slashes. For example,
[File/Create/Folder].
Symbols

Convention

-

\ |

Description

This implies about the notice or pays attention to, in the manual

[ B¢

The general information which helps in performing the operations faster

The information which is significant

Care taken to avoid danger or mistakes

The statement or event that warns of something or that serves as a cautionary
example.
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Safety Instructions

Important Security Instructions

Read and follow the instructions carefully before operation. Please keep the instructions for
future reference.

Accessories: Please use the accessories recommended by the manufacturer or delivered with the
product. Other accessories are not recommended, including major alarming systems and
monitoring systems. The primary alarming and monitoring system should comply with the local
applicable fire-prevention and security standards.

Installation cautions: Do not place this equipment on an unstable table, tripod mount, support,
or base, lest the equipment falls and get damaged or any other undesirable outcome resulting
in severe personal injuries. Therefore, it is essential to install the equipment as instructed by the
manufacturer.

All peripheral devices must be grounded.

No external connection wires can be exposed. All the connections and idle wire ends must be
wrapped with insulating tapes to prevent any damage to the equipment by accidental contact
of the exposed wires.

Repair: Do not attempt to have an unauthorized repair of the equipment. Disassembly or
detachment is risky and likely to cause shock. All repairs should be done by a qualified
technician.

If any of the following cases arise, disconnect the power supply from the equipment first and
intimate the technician immediately.

The power cord or connector is damaged.
Any liquid or material spilled into the equipment.
The equipment is wet or exposed to bad weather (rain, snow, etc.).

If the equipment cannot work properly, even if it is operated as instructed, please be sure to adjust
only the control components specified in the operating instructions. Incorrect adjustments on
other control components may cause damage to the equipment; even the equipment may fail to
operate permanently.

The equipment falls, or its performance changes dramatically.

Replacing components: If it is necessary to replace a component, only the authorized technician
can replace the accessories specified by the manufacturer.

Security inspection: After the equipment is repaired, the technician must conduct security
inspection to ensure proper working of the equipment.
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Power supply: Operate the equipment with only the type of power supply indicated on the label.
Contact the technician for any uncertainty about the type of power supply.

®

o

~

Violation of any of the following cautions is likely to result in personal injury or equipment
failure. We will not be responsible for the damages or injuries caused thereby.

Before installation, switch off the external circuit (that supplies power to the system),
including locks.

Before connecting the equipment to the power supply, ensure the output voltage is within the
specified range.

Never connect the power before completion of installation. j

In
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stallation Instructions

The conduits of wires under relay must match with the metal conduits; other wires can use PVC
conduits, to prevent failure caused by rodent damage. The Control panel is designed with
proper antistatic, lightning-proof, and leakage-proof functions, ensure its chassis and the AC
ground wire are correctly connected and the AC ground wire is grounded physically.

It is recommended not to plug/unplug connection terminals frequently when the system is
powered on. Be sure to unplug the connection terminals before starting any relevant welding
job.

Do not detach or replace any control panel chip without permission, and an unpermitted
operation may cause damage to the control panel.

It is recommended not to connect any other auxiliary devices without permission. All
non-routine operations must be communicated to our engineers in advance.

A control panel should not share the same power socket with any other large-current device.

It is preferable to install card readers and buttons at the height of 1.4 to 1.5m above the ground
or subject to customers’ usual practice for proper adjustment.

It is advised to install control panels at places where maintenance is easy, like a weak electric
well.

It is strongly recommended that the exposed part of any connection terminal should not be
longer than 4mm, and specialized clamping tools may be used to avoid short-circuit or
communication failure resulting from accidental contact with excessively exposed wires.

To save access control event records, export the data periodically from control panels.

Prepare countermeasures according to application scenarios for unexpected power failure, like
selecting power supply with UPS.
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If RS485 reader is connected externally and shared the power supply with the device (The
control panel does not support fingerprint verification of RS485 reader), it is recommended that
the connection between the RS485 reader port and the reader be no longer than 100m.
Otherwise, it is recommended that the reader use a separate power supply.

To protect the access control system against the self-induced electromotive force generated by
an electronic lock at the instant of switching off/on, it is necessary to connect a diode in
parallel (please use the FR107 delivered with the system) with the electronic lock to release the
self-induced electromotive force during onsite connection for application of the access control

system.

It is recommended that an electronic lock and a control panel should use separate power
supplies.

It is recommended to use the power supply delivered with the system as the control panel
power supply.

In a place with substantial magnetic interference, galvanized steel pipes or shielded cables are
recommended, and proper grounding is required.
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System Introduction

The Access Control management system is a new modernized security management system, which is an
effective measure of security and protection management. It is mainly used to manage the entrances and
exits of highly secured places, such as banks, hotels, equipment rooms, offices, smart communities, and
factories.

System Functional Parameters

High-speed 32-bit 1.0GHz CPU and 64M RAM.

Embedded LINUX operating system.

Two-door one-way/two-way.

User capacity: 30,000.

A maximum of 30,000 cardholders.

200,000 offline event records.

Use Ethernet communication technologies for reliable communications.
Control Panel with a watchdog (hardware) built in to prevent a crash.
Over-current, over-voltage, and inverse-voltage protection for the input of the power supply to
the control panel.

Over-current protection for the power supply to card readers.

Instant over-voltage protection for all input/output ports.

Instant over-voltage protection for communication ports.

Product Technical Parameters

Working Power supply: Rated voltage 12V (£20%) DC, rated current is = 3A

Working environment: Temperature -10°C to 50°C; Humidity 20% to 80%.

Electronic lock relay output: The maximum switching voltage is 36V(DC); The maximum switching
current is 5A.

Auxiliary relay output: The maximum switching voltage is 36V(DC); The maximum switching
current is 2A.

The detachable connection terminals are made of alloy-steel non-magnetic flange materials.
Control panel dimensions: 116.5mm*96.5mm*31.3mm

Control Panel Indicators

When the C2-260 is powered on, normally the POWER indicator (red) is lit constantly, the RUN indicator
(green) shall flash slowly (indicating the system is normal), and other indicators are all off.

COMM indicator (yellow): It flashes when the system is communicating with other devices (e.g., PC). When
the indicator is flashing continuously, it indicates data transmission. When the indicator is flashing slowly,
it indicates real-time monitoring status.
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Indicator Diagram:
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Installation and Connection

Installation Procedure

The following describes the rail installation process.

NS @ 0
E Guide I’a-il> g
< g |

1) Fix the guide rail on the wall 2) Fix the device to the guide rail.

The following describes the wall installation process.

1) Drill holes on the wall 2) Fix the device with four screws
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Installation of Access Control Panel Wires

—_ = — — v
+12V Power line

TCP/IP Network communication wire RS485 Network communication wire

Ceiling

7— Control Panel

v <~ 7 7/ 7 / / 7~ /7 /S /S /S 7 ]
ly Door sensor

| u )
[ ] Electronic lock

Outdoor

[ 1
reader

T 1
Outdoor ' | ' | ' | Indoor

Indoor reader

Ex‘L
_.:zT

Access Control Panel Wire Installation Diagram
Remarks:

Ensure the power supply is disconnected before connecting the wires; otherwise, it may cause
severe damage to the equipment.

The access control wires must be separated according to heavy and light current; the control panel
wires, electronic lock wires, and exit button wires must run through their casing pipes, respectively.
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Control Panel System Installation
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Schematic Diagram of System Installation

The access control management system consists of two parts: Management Workstation (PC) and Control
panel. The management workstation and control panel communicate through TCP/IP and RS485 network.
The communication wires should be kept away from high-voltage wires as far as possible and should be
neither routed in parallel with nor bundled with power wires.

A management workstation is a PC connected with the network. By running the access control
management software installed in the PC, access control management personnel can remotely perform
various management functions, like adding/deleting a user, viewing event records, opening/closing doors,

and monitoring the status of each door in real-time.
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Control Panel Connection Terminals

C2-260 Terminal connection diagram
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Description of the terminals:

The auxiliary input may connect to infrared body detectors, fire alarms, or smoke detectors.
The auxiliary output may connect to alarms, cameras or doorbells, etc.

PC RS485 indicates the RS485 cable is connected to the DM10/AUX485 through this port. The
RS485 Reader port can be connected externally to RS485 reader.

Restore factory setting: The NO.4 of DIP switch is OFF by default. When it is moved up and
down for three times within 5 seconds and finally returned to ON position, the factory settings
will be restored after the access control panel is restarted, and the IP address will restore to the
default (192.168.1.201).

The terminals above are set through the relevant access control software. Please see the

respective software manual for further details.
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Ports of C2-260 Control Panel:

1 Exit button 2
2 Control lock relay 2
3 Door Sensor 2
4 Auxiliary Input 2
5 Auxiliary Output 2
6 RS485 Reader 4

RS485 Extension
Communication

8 TCP/IP v

Connection with Door Sensors, Exit Switches, Auxiliary

Input Devices, and RS485 Extension Communication

Door sensor

A Door Sensor is used to sense the open/close status of a door. With a door sensor switch, an access
control panel can detect the unauthorized opening of a door and will trigger the output of alarm.
Moreover, if a door is not closed within a specified period after it is opened, the door control panel will
also raise the alarm. It is recommended to select two-core wires with a gauge over 0.22 mm?. A door
sensor can be omitted if it is unnecessary to monitor the open/closed status of a door, raise the alarm
when the door is not closed for a long time, monitor if there is unauthorized access, and use the interlock
function.

Exit switch

An exit switch is a switch installed indoor to open a door. When it is switched on, the door will be opened.
An exit button is fixed at the height of about 1.4m above the ground. Ensure it is located in the right
position without slant, and its connection is correct and secure. (Cut off the exposed end of any unused
wire and wrap it with insulating tape.) Make sure to avoid electromagnetic interference (such as light
switches and computers). It is recommended to use two-core wires with a gauge over 0.3mm?as the
connection wire between an exit switch and the Control panel.
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Auxiliary input

The control panel provides one auxiliary input interface which may connect to infrared body detectors,
smoke detectors, gas detectors, window magnetic alarms, wireless exit switches, etc. Auxiliary inputs are
set through the relevant access control software. Please see the respective software manual for further
details.

o O
z z

AUX OUT

,}‘ Rs485 DIP

Connections between Control Panel and Door Sensors, Exit Switches and Auxiliary Input Devices

RS485 extension communication

The Control panel supports extensive modules which like DM10 and AUX485, through RS485. A C2-260
can connect eight DM10 at most or can connect two AUX485 at most. As shown in the following figure.
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o
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Connect with AUX485 through RS485

Note:

1. A C2-260 can connect to maximum eight DM10 modules or two AUX485 modules.
2. Each AUX485 module can connect to maximum four auxiliary devices.

3. Each DM10/AUX485 module requires a separate power supply.

Page |17 Copyright©2021 ZKTECO CO., LTD.  All rights reserved.



(C2-260 Access Control Panel User Manual

Connection with RS485/Wiegand Readers

The Control panel supports RS485 card reader. And it also supports Wiegand reader, through WR485.

Connection with RS485 Readers

The Control panel supports four readers, which can be connected in the two-door two-way mode.

RS485 reader connection: Set the RS485 address (device number) of the reader by DIP switch or other ways.

RS485 address
Control Panel

C2-260 Door1 (In) | Door1 (Out) | Door2 (In) | Door2 (Out)

TCP/IP
&g

7 I I I [

INIRIRL

1# Reader 2# Reader 3# Reader 44 Reader

The connection between the Control Panel and RS485 Card Readers

A single RS485 reader interface can supply a maximum of 750 mA (12V) current. So, the entire current
consumption should be less than this maximum value when the readers share power with the panel. For
calculation, please use the maximum current of the reader, and starting current is usually more than twice
the standard work current.

Using the KR502M-RS card reader as an example, the standby current is less than 80mA; the maximum
current is less than 90mA. When starting the device, the instantaneous current can reach 180 mA. For an
RS485 reader, considered that the starting current is large, only four readers can connect to the power
supply through the RS485 reader interface. So, the power of the control panel can only connect up to 2
readers.

If RS485 reader is connected externally and shares the power supply with the device, it is recommended
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that the connection between the RS485 reader port and the reader be no longer than 100m. Otherwise, it
is recommended to use a separate power supply for the reader.

For the devices which consume more power, we suggest using different power supplies to ensure

steady operation.

Connection with Wiegand Readers

The Control panel supports the connection of Wiegand reader via WR485 module. The wiring is shown in the

figure below.

ZKBioAccess

Router

485A
4858
GND
+12V
@1#WR485 3 .o @ 4% WR485§
[ =] (=]
i / .yi(@H % ©)
oo DD G
| Do0® | D (® &
L o D@D @
\\@@/ )
KR602E KR602E

The connection between the Control Panel and Wiegand Readers via WR485

#

L Notes:

A C2-260 can connect to maximum four WR485 modules.

Because the WR485 is an encryption mode, after the C2-260 control panel is added to the

ZKBioAccess software, you need to set the "Encrypt"” option for the Wiegand reader. So that

the Wiegand reader can be used normally. As shown in the following figure.

For further details and settings of the parameters, see Appendix 1.
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Ao & 9 ¢
Reader Name Door Name Q ®
The current query conditions Mone
(% Refresh
Reader Name Door Name Number C icati C icati In/Cut Bound camera Cwning Boeard Cperations
Type Address
192.168.5.240-1-In 192.168.5.240-1 1 RS485 1 In 2 gm
Edit Cut Edit Binding/unbindid
Door Name”™ 192.168.5.240-1 In Edit Binding/unbindij
Name" 192.168.5.240-1-n I Bt S nd ngrunfingy
Number* 1
In/Cut* In Out

Communication Type® RS485 W
RS485 Address’ 1

Encrypt X Select the check box

A

Real-Time Mc

Alarm Monitoring

Map

Relay Output Connection

C2-260 has three relays (two used as control locks by default, and the other one used as auxiliary outputs).

The relays for auxiliary outputs may connect to monitors, alarms, doorbells, etc. Auxiliary outputs are set
through the relevant access control software. Please refer to the respective software manual for details.

The default connection mode of the door lock is “dry mode.” In general, the electronic lock uses an
external power supply separately. The wiring mode of the door lock relay cannot be changed, except
that the auxiliary output relay. The diagram below uses the example of a door lock connection to
demonstrate the output relay connection.

An access control panel provides multiple electronic lock outputs. The COM and NO terminals apply
to the locks that are unlocked when power is connected and locked when power is disconnected.
The COM and NC terminals use the locks that are locked when power is connected and unlocked

when power is disconnected.

Our access control panel is powered by standard PoE or access control power. You can choose either
one of the power supplies as needed. Both two power supplies provide 12V/3A power for only the
power consumption of the control panel, Wiegand readers, and output power consumption of
RS485 reader.

To protect the access control system against the self-induced electromotive force generated by an
electronic lock at the instant of switching off/on, it is necessary to connect a diode in parallel (please
use FR107 delivered with the system) with the electronic lock to release the self-induced
electromotive force during the onsite connection for application of the access control system.
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Equipment Communication

The background PC software can communicate with the system according to two protocols (TCP/IP and
RS485) for data exchange and remote management.

Access Control Networking Wires and Wiring

The power supply is 12V DC converted from 220V or PoE.

As an electronic lock has a large current, it generates a strong interference signal while functioning.
To reduce such an effect, 4-core wires (RVVP 4 X 0.75mm?, two for a power supply, and two for a door
sensor) are recommended.

“RS485" interface uses 4-core communication shielded wires (RVVSP 4*0.5mm).
Other control cables (like exit switches) are all made of 2-core wires (RVVSP 2 X 0.5mm?).
Notes for wiring:

Signal wires (like network cables) can neither run in parallel with nor share one casing pipe with
large-power electric wires (like electronic lock wires and power cables). If parallel wiring is
unavoidable for environmental reasons, the distance must be above 50cm.

Try to avoid using any conductor with a connector during distribution. When a connector is
indispensable, it must be crimped or welded. No mechanical force can be applied to the joint or
branch of conductors.

In a building, the distribution lines must be installed horizontally or vertically. They should be
protected in casing pipes (like plastic or iron water pipes, to be selected according to the
technical requirements of the indoor distribution). Metal hoses are applicable to ceiling wiring,
but they must be secure and good-looking.

Shielding measures and shielding connection: If the electromagnetic interference in the wiring
environment is found substantial in the survey before construction, it is necessary to consider the
shielding protection of data cables when designing a construction scheme. Overall, shielding
protection is required if there is a large radioactive interference source or wiring has to be parallel
with a large-current power supply on the construction site. Generally, shielding measures
includes keeping a maximum distance from any interference source, and using metal wiring
troughs or galvanized metal water pipes to ensure reliable grounding of the connection between
the shielding layers of data cables and the metal troughs or pipes. Noted that a shielding
enclosure can have a shielding effect only when it is grounded reliably.

Ground wire connection method: Reliable large-diameter ground wires in compliance with
applicable national standards are needed on the wiring site and should be connected in a tree
form to avoid DC loop. These ground wires must be kept far away from lightning fields. No
lightning conductor can serve as a ground wire and ensure there is no lightning current through
any ground wire when there is lightning. Metal wiring troughs and pipes must be connected
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continuously and reliably and linked to ground wires through large-diameter cables. The

impedance of this section of wire cannot exceed 2 ohms. Also, the shielding layer must be

connected reliably and grounded at one end to guarantee a uniform current direction. The

ground wire of the shielding layer must be connected through a large-diameter wire (not less

than 2.5mm?).

TCP/IP Communication

The Ethernet 10/100Base-T Crossover Cable, a type of crossover network cable, is mainly used for

cascading hubs and switches or used to connect two Ethernet endpoints directly (without a hub). Both

10Base-T and 100Base-T are supported.

TCP/IP

A,

1# Control Panel

TCP/IP Communication System Networking

é Printer

L I
_f.—D Card Issuer

2# Control Panel

N# Control Panel

In Access software: Click Device > Search Device to search for access controllers in the network, and

directly add from the search result.

ZKPanelWeb

This built-in function is newly added to assist user to manage controllers more conveniently. Users can use

the Web Server function to perform operations, such as network configuration, push communication

configuration, time synchronization, and user account management.

Log on to the Web Server

Create a valid connection string using TCP/IP.

Input the IP address of the controller (factory default is 192.168.1.201) in the address bar; enter the user

name and password (both are admin), and click [Sign In] to access the ZKPanelWeb.
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ZK

User Login

User Name

Password

Note:

1. IP addresses of both the server (PC) and the controller must be in the same network segment.
2. IP address of the controller could be found by searching devices with the BioSecurity software
([Access] > [Access Device] > [Device] > [Search Device]).

o  TCP/IP Settings

Click [TCP/IP Settings] to modify the IP address and gateway address.

(€)> ¢ @ © & 192.168.1.201/main.html

fI_.l Network Settings (@8] TCP/IP Settings

Primary Metwork Card Setting
IP Address: | 192.168.1.201 *
ommunication Settings SubnetMask||Prsee oEED R
Server Settings Gateway: | 192.168.1.254 *
Communication Password Primary DNS: | 0.0.0.0

Time Settings

System Settings

Device Information

o Communication Settings

Set communication parameters in ZKPanelWeb and connect the controller to the server (PC); the controller
will automatically push information to the server.

1) Server Settings
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(— c @ © & 192.168.1.201/main.html

L_I_.l Network Settings & Server Settings
_ Mote:If both the IP mode and the domain mode are available, the domain node is preferred.
TCP/IP Settings
Use mode settings @ Connectto BioSecurity () Connectto mian device
Communication Settings
g BioSecurity Server Settings: @ IP Mode () Domain Mode
IP Address: 192.168.222.5

Communication Password Port: 8088

Use mode settings: The default mode is Connect to BioSecurity.
BioSecurity Server Settings: To set the parameters of the IP Mode and Domain Mode.
IP Mode: The default server IP is 0.0.0.0, and you can modify it according to the practical situation.

Port: The default Port is 8088, and you can modify it according to the practical situation.

Server Settings
Mote:If both the IP mode and the domain mode are available, the domain node is preferred.
Use mode seftings @ Connectto BioSecurity ) Connectto mian device
BioSecurity Server Settings: () IP Mode @ Domain Mode

Domain Name: https:/192 168.222 51

Domain Mode: The default value is null, and you can set its value. If the user wants to login to the BioSecurity
software via HTTPS, then set the domain name here. The format is: https://192.168.222.5:8088.

2) Communication Password

<— c @ © & 192.168.1.201/main.html

Teco

rh Network Settings @] Communication Password

_ Old Password: I:I Enter a string of 0-6 characters!
TCP/IP Settings
Mew Password: Enter a string of 0-6 characters!
Communication Settings
g Confirm Mew Password: Enter a string of 0-6 characters!
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Communication Password: Indicates that network communication is encrypted. The default value is null,
and you can set its value.

If you configure the communication password here, the same communication password must be configured
on the server before the connection can be set up.

o System
The user can synchronize time to the computer, set up the system and view device information here.

1) Time Settings

(— C @ © & 192.168.1.201/main.html

Teca

FI_J Network Settings &) Time Settings

_ Current Time: 20
TCP/IP Settings
Synchronization with Computer Time

Communication Settings & e P

Communication Password

/stem

System Settings

Device Information

2) System Settings

(— c © & 192.168.1.201/main.html

L_I_.I Network Settings (@8] System Settings
Reboot Device: Reboot

Restore Factory Setting:

TCP/IP Settings

Communication Settings

Server Settings

Communication Password

System

Time Settings

Device Information
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3) Device Information

&« ¢ @ © & 192.168.1.201/main.html 5

Tzco

FI_J Network Settings Device Information

. ) Device Name: C2-260
TCP/IP Settings

Serial Number: 5322182000012
Communication Settings Platform: | ZLM80_C2
Server Settings Firmware Version: AC Ver 9.0.2.0014 Sep 18 2020
Communication P Maximum user count. 30000  Remaining Capacity: -70000
System Maximum log count: 200000

MAC Address: 00:17:61:11:84.E7

Time Settings

IP Address: 192.168.1.201

System Settings

Subnet Mask:| 255.255.255.0
Gateway: 192.168.1.254

Primary DMS: 0.0.0.0

TCP Port: 4370
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ZKBioAccess

The following sections explain the functions of ZKBioAccess software after the Access Controllers are
installed.

Login

User Login

After installing the software, double-click the ZKBio Access icon @ to open the software. You may also

open the recommended browser and enter the IP address and server port in the address bar. The IP
address is http://127.0.0.1:8098 by default.

If the software is not installed in your server, you may enter the IP address and server port in the address
bar.

e

L Note: The username of the superuser is admin, and the password is admin, then click Login. After

logging in for the first time, you need to reset your password.

Activate the System

Please refer to the corresponding license activation document.

Modify Password

You can modify the login password in the Personal Information section.

Welcome, admin

Click here to open modify interface
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Username®

Reset Password

Password™

Confirm Password®
Superuser State
Role

Auth Department

Authorize Area

Email

First Mame

Personal Information

admin

Usermame should be composed between 1-30 characters and

in letters,numbers,or symbols (@/./-+/_).

[l
Password is a8 ~ nf 4 to 18 characters, default is
111111,
Select the check
. box to reset
I you select no department, you will possess all department

rights by default.

Ii you select no area, you will possess all area righis by

default.

admin

Select the Reset Password checkbox to modify the password.

#

L Note: Both the Superuser and the new user are created by the Superuser (the default password for

the new usersis 111111). The username is not case-insensitive, but the password is case-sensitive.

Device

The Device Settings adds an access device and then sets the communication parameters of the connected

devices, including system settings and device settings. When the communication is successful, you can

view here the information of the connected devices, and perform remote monitoring, uploading and

downloading, etc.
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Adding a Device

There are two ways to add Access Devices.

Add Device by Searching Access Controllers.

Search the Access Controllers in the Ethernet.

Welcome, admin

DeviceName| | Serial Number Search Device
The current query conditions None 4
3 No device found? Download Search Tools to Local Disk
(' Refresh [® New (fi} Delete [ # Export QSeathevti
Searched devices count:4
: : | Tota Progres | OO | bor of cevices added ¢
|| Device Name Serial Number ~ AreaName  Com
TVPE  |p Address Device Type Serial Number ®
[ 1921680105 CJHB192960013 AreaName  HTTI  IP Address MAL Address SubnetMask  Gateway Address  Serial Number  Device Type  Set Server Operal
[ 192.168.10.232 CJI4193360005 AreaName  HET| 1921680105 2562652550 0000 CJHB192960013 SmartAC1 This d
[ 19216810219 CJ75192460017 AreaName  HTTI 192168176 2552652550  0.0.0.0 CJT4192960006  ProFace X This d
[ CJ74192960006 AreaName  HFT| 192.168.10.219 2552652660 192.168.10.254 CJ75192460017  ProFace X[CH This d
192.168.10.232 2552652650  192.168.10.254 CJI4193360005  SpeedFace V! This d
Real-Time
Alarm M
Map A\ The current system communication port is 808
«
® < 1-4 > 3l 50 rows perpage ~ JumpTo 1 'age

Click Access > Device > Search Device to open the Search interface.

Click Search, and it will prompt Searching.......
After the search is complete, the list and the total number of access controllers will be displayed.

Search Device

m Mo device found? Download Search Toaols fo Local Disk
Searched devices count:2

Total Progress | NG | 1,.iber of devices added:

IP Address Device Type Zerial Mumber ®

IP Address MAC Address Subnet Mask Gateway Address Zerial Number Device Type  Sef Server Operations
192.165.1.201 2552552550 0.0.00 5264183100152 TDBO3 Add
192.168.213.67 2552552550  192.168.213.1 CGFE184760043 SpeedFace-\! This device has been added

A\ The current system communication port is 8881, please make sure the device is set comectly.

Close
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#

L~ Note: UDP broadcast mode will be used to search the access devices. This mode cannot perform a

cross-router function. The IP address can provide a cross-net segment, but it must be in the same subnet,
and the Gateway and IP Address must be configured in the same network segment.

Click Add in the search list.

If the device is a pull device, you may enter a device name and click OK to complete adding the device.

M ew
Device Mame*
Communication Type® i@ TCPR/IP
IP Address®
Communication port® 4370
Communication Passward
lcon Type™® Doar
Control Panel Type One-Door Access Conl
Area® Area hame
Add to Level —_
Clear Data in the Device when 0
Adding
Ak [Clear Data in the Device when Adding] will delete data in the device

(except event record), please use with caution!

Coeanonen B o Jcarcer

Clear Data in the device when Adding: If this option is selected, after adding a device, the system will

clear all data in the device (except the event logs).

If the device is a push firmware device, the following windows will pop-up after clicking Add. If the IP
Address in New Server Address is selected, then configure the IP address and port number. If Domain
Address in New Server Address option is selected, then set the Domain address, port number, and DNS.
The device will be added to the software automatically.
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Add
Device Name® 192.168.213.155
New Server Address™® @IP Address ()Domain Address

192 168 . 213 .25
New Server Port*® 8088

Communication Password

Icon Type® Door

Area* Area Name

Add to Level _

Clear Data in the Device when Adding [}

Al jelete data in the device (except event

Mew

Device Name*

Communication Type® i@ TCPAP

IP Address®

Communication port* 4370

Communication Password

Icon Type® Door

Control Panel Type One-Door Access Conl
Area* Area Name

Add to Level _

Clear Data in the Device when ]

Adding
A C 3 & data & device

New Server Address: To add a device by IP Address or Domain Address, devices can be added to the
software by entering the domain address.

New Server Port: Set the access point of the system.
DNS: Set a DNS address of the server.

Clear Data in the Device when Adding: If this option is selected, then after adding a device, the system
will clear all data in the device (except the event logs). If you add the device merely for demonstration or
testing, there is no need to select it.
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L~ Note: When using either of the above three device adding methods, if there exists a residual data in

the original device, please sync the original data to it after adding a new device to the software by clicking
Device > Synchronize All Data to Devices, otherwise, these original data may conflict with normal
usage.

The current query conditions None
(¥ Refresh New [ Delete [# Export Q SearchDevice [ Device Control ~ §6% Setup ~ [Q] View and Get Devicelnfo ~ & Communication ~

: : - Clear Administrator permission
2. Click on Device Control érjnrr Lt RS485 Status  Device Register  Firmware Version

T Type b, Ungrade Firmware Parameter Model Davice

Reboot Device

v 192.168.213.67 CGFE134760043 Area Mame HTTP ‘FE]I Synchronize Time Cnline SpeedFace-\V: @ 1.0.55

Device,

~” Enable
() Disable

'fl('; Synchronize All Data to Devices

1. Select the required device

™ 3. Click here

e —_

The default IP address of the access device may conflict with the IP of a device on the local network.
You can modify its IP address: click Modify IP Address, and a dialog box will pop up in the
interface. Enter the new IP address and other parameters (Note: Configure the gateway and IP
address in the same network segment).

L— Note: Some PUSH devices support SSL. To use this function, select the HTTPS port during software

installation and ensure that the device firmware supports SSL.
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I/0 Board

On the device module, click Device > I/O Board > New to add the I/0 Board device to the software.

4

® owerome | e B Q ®

E] Devi The current query conditions None
evice

("% Refresh New ([ Delete

Device

O Name Area Name Owned Device Number I/O Board Type  RS485 Address  Operations
Door

Reader

Auxiliary Input

New
Auxiliary Qutput
Event Ty
T Device Name” Click to select
Daylight Saving Time 110 Board Type® ——
Device Monitoring R3485 Address
R34385 Address Code Figure ON KE.

Real-Time Monitoring

[ XX X ]

123 4

Alarm Monitoring

Map

Cove aranen o J oo ]

Enter the name of the 1/0 Board. Select the Device by clicking the Device Name field. The device list
appears, as shown below:

Device Name I:l Serial Number Q @

The current query conditions Mone

Alternative Selected(0)

Device Name Serial Number Device Name Serial Number

0 50 rows perpage ~  Total of 0 records

Cancel

Select the device and click OK. Select the I/0 Board Type. Set the RS485 Code Address by changing the
corresponding button. Click OK to save the details. You can view all the auxiliary inputs in the Auxiliary
Input interface.

Note: Please select this method when adding DM10 and AUX485.
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Device Operation

For the communication between the system and device, data uploading, configuration downloading,
device, and system parameters shall be set. Users can edit the access controllers within the appropriate
levels in the current system; users can only add or delete devices in Device Management if needed.

(+ Refresn  [® New [} Delete [# Expot O SearchDevice S Device Control ~ {83 Setup ~ [ Viewand GetDevicelnfo ~ & Communication ~
3 Clear Administrator permission

+  Device Name Serial Number Area Communic: Status  Device Register  Firmware Operations

Name Type .L Upgrade Firmware ameter Model Device Version

D Reboot Device

+  SpeedFaceVS  CGFE184760043  Area Name HTTP 1 Synchronize Time Offine  SpeedFaceV: & 1.0.55 Edit Delete
~/ Enable
@) Disable

". Synchronize All Data to Devices

s

(% Refresh E’? New ﬁﬁ,“ Delete B Export Q) Search Device 2 Device Control ~ {é} Setup ~ @V\ewand Get Device Info ~ & Communication ~

Set Device Time Zone

&

v Device Name Serial Number Area Communici  Network IPA egister Firmware Operations
Name Type Connection 'ic Set as Registration Device evice  Version
o g‘ Set Daylight Saving Time
v SpeedFace-V5 CGFE184760043  Area Name HTTP Wired 192137  Modify the Fingerprint Identification Threshold 1.0.55 Edit Delete
2%, Set Device In/Out State

(" Refresh [ New [fi* Delete [# Export Q) SearchDevice 2 Device Control ~ {83 Setup ~ [Q Viewand Get Device Info = & Communication ~
€30 Get Device Option

v Device Name Serial Number Area Communic: Network IP Address RS4 Register Firmware Operations
Name Type Connection Pare 8 Get Personnel Information  Device  Version
e [] Get Transactions
+  SpeedFace-V5  CGFE184760043  Area Name HTTP Wired 192.168.213.67 3 View Rules of Devices o 1.0.55 Edit Delete

=% View Device Capacity

C\- Refresh L@ New ﬁ'ﬁ]‘ Delete g Export Q Search Device 2. Device Control ~ {:i} Setup @\ﬁewand Get Device Info = @ Communication ~

12 Modify IP Address

v Device Name Serial Number Area Communici Netwark IP Address RS485 Status Device .
Name Type Connection Parameter Model f Modify Communication Password
Mode “ Switch Network Connection
v SpeedFace-V5 CGFE184760043 Area Name HTTP Wired 192 168 213 67 Offline SpeedFace-V: & 1.055 Edit Delete

Edit or Delete a Device

Edit: Click the Device Name or click Edit to access the edit interface.

Delete: Select the device, click Delete, and click OK to delete the device.
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Edit

Device Name®

‘ [SpeedFace-V5

=

Communication Type

Serial Number”

TCP/IP o HTTP

CGFE184760043

IP Address” 192 .168 .213 .67
Communication port™ 6665

lcon Type™ Door

Control Panel Type

Area” Area Name

Set Wiegand Reader Click to select the reader  |(X)

A\ [Clear Data in the Device when Adding] will delete data in the device (except event
record), please use with caution!

For further details and settings of the above parameters, see_Device. Some details cannot be edited. The

device Name should be unique and must not be identical to another device.
Control Panel Type cannot be modified. If the type is wrong, users need to delete the device and add it

again manually.

Export

Device information can be exported in EXCEL, PDF, and CSV file formats.

The File Type

Export Maode

Export

EXCEL File v
® All data (export up to 30000 pieces of data)

Select data volume export (export up to 30000 pieces of data)

From the article 1

o I e |

Strip, is derived 100 Data

Device
Device Name Serial Number |[Area Name|Com munic Network [P Address RS485 Status Device Register Firmware Version
ation Type Connection Parameter Model Device
Mode
SpeedFace-V5 CGFE184760043 |Area Name| HTTP Wired 192.168.213.67 Offline | SpeedFace- Yes 1.0.55
V5
Disable/Enable

Select a device, click Disable/ Enable to stop/ start using the device. When the communication between
the device and the system is interrupted, or the device fails, the device may automatically appear in
disabled status. After adjusting the local network or device, click Enable to reconnect the device and

restore device communication.

Page |36

Copyright©2021 ZKTECO CO,, LTD.  All rights reserved.



(C2-260 Access Control Panel User Manual

The current query conditions MNone

(v Refresh  [® New (i Delete [# Export O Search Device [2 Device Control v 8% Sefup

2. Click on Device Control E;:n i
Type 1. Upgrade Firmware

Reboot Device

) i Clear Administrator permission
v Device N\

v SpeedFace V5 CGFE184760043  Area Mame HTTP ‘{3,_]. Synchronize Time
" Enable

| 1. Select the required device (@) Disanie

v Synchronize All Data to Devices

3. Click as required

Synchronize All Data to Devices

To synchronize data of the system to the device, select the device and click Synchronize All Data to

Devices and click OK to complete synchronization.

The current query conditions None

(_* Refresh @ New ﬁf} Delete l—_,’ Export Q Search Device _.?;, Device Control = ﬁ;} Setup = EQ] View and Get Device Info ~ @ Communication =

g Device s, 2. Click on Device Control Comir ﬁ Clear AgmiEtStor permzton RS485 Status Device Model Register  Firmware Version
ame Type 1, Upgrade Firmuware Parameter Device
Reboot Device
+  SpeedFace V5 CGFE184760043  Area Name HTTP ‘[Eé Synchronize Time Cnline SpeedFace-V5 a 1.0.55
\ ~/ Enable
1. Select the required device @) Disabie

'ﬂ;, Synchronize All Data to Devices

™ 3. Click here
—

Synchronize All Data to Devices

Selected Device
# Standalone Device : SpeedFace-V5

@ Access Authority « TimeZone, holidays « Multi-Person Open Door

Cleagat ¥ First-Person Open Door

Total Progress

[ |

Note: Synchronize All Data to Devices will delete all the data in the device first (except transactions),

and thus download all settings again. Please keep the internet connection stable and avoid power down
situations. If the device is working normally, please use this function with caution. Execute it in rare user

situations to prevent impact on the regular use of the device.
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Upgrade Firmware

Select the required device that needs to be upgraded, click Upgrade firmware to enter the edit interface,
then click Choose File to select the firmware upgrade file (named emfw.cfg) provided by the Access
software, and click OK to start upgrading.

Upgrade Firmware

Selected Devicel{Can only upgrade eguipment of the same type)
(») SpeedFace-V5 : SpeedFace V5

Select File| Choose File | Mo file chosen

[Total Progress

#

Note: The user shall not upgrade firmware without authorization. Contact the distributor before

upgrading the firmware or upgrade it by following the instructions of the distributor. The unauthorized
upgrade may affect normal operations.

Reboot Device

It will reboot the selected device.

Synchronize Time

It will synchronize the device time with the server’s current time.

Set Device Time Zone

If the device supports the time zone settings and is not in the same time zone with the server, you need to
set the time zone of the device. After setting the time zone, the device will automatically synchronize the
time according to the time zone and server time.

Set as Registration device

Set the registration device only when the standalone device’s data such as personnel can automatically
upload.
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Set as Registration Device

Set as Registration Device Yes

Set Daylight Saving Time

According to the requirements of different regions, set the Daylight-Saving Time rules.

Modify the fingerprint identification threshold (Ensure that the access controller supports

fingerprint function)

Modify the Fingerprint |dentification Threshold

The fingerprint identification threshold® (35-.?03

Set Device In/Out State

It will define the condition of the master device as Entry or Exit.
Set Device In/Cut State

IMaster device state Entry r
Out

Get Device Option

It gets the common parameters of the device. For example, it gets the firmware version after the device is
updated.
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Get Personnel Information

It displays the current number of personnel, fingerprints, finger vein, and face templates in the device. The
final value will be displayed in the device list.

Get Personnel Information

Selected Device
(e SpeedFace-V5 : SpeadFace V5 |

You can choose the required option |

V4

i

(®) Obtain personnel information (_1Obtain fingerprint infarmation
() Obtain Face Picture Information

[] Get count only

ITotal Progress

Get Transactions

It fetches the transactions from the device into the system. Two options are provided for this operation:
Get New Transactions and Get All Transactions.

Get New Transactions: The system only gets new transactions since the last collected and recorded
transaction. Repeated transactions will not be rewritten.

Get All Transactions: The system will get transactions again. Repeated entries will not be shown twice.

When the network status is healthy, and the communication between the system and device is normal,
the system will acquire the transactions of the device in real-time and save them into the system database.
However, when the network is interrupted, or communication is interrupted for any reason, and the
transactions of the device have not been uploaded into the system in real-time, Get Transactions can be
used to acquire transactions of the device manually. Besides, the system, by default, will automatically
acquire transactions of the device at 00:00 on each day.

#

Note: An Access controller can store up to 100 thousand transactions. When transactions exceed this

number, the device will automatically delete the oldest stored transactions (deletes 10 thousand
transactions by default).
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View Rules of Devices

Shows the Access rules in the device.

View Rules of Devices

Rule Type Description Rules Details
First-Person Normally Open Not Set None
Multi-Person Opening Door Not Set

Door Sensor Not Sat

Active Time Zone Has been set

Passage Mode Time Zone Not Set

Between multiple rules
with a | separated.

A\ Linkage and global
linkage, anti-passback
and global anti-passback
are set at the same time,

there may be conflicts.

View Device Capacity

It displays the capacity of personnel’s biometric details in the device.

View Device Capacity
In Software In FirmWare
& @ ] - & @ ¥ ) Get Al
SpeedFace-V5  5/10000 0/10000 X 1/6000 Get
A\ 'fyou find that the data is not consistent with the device, please synchronize the data of devices before trying again
Cancel

Modify IP Address

Select a device and click [Modify IP address] to open the modification interface. It will obtain a real-time
network gateway and subnet mask from the device. (Failed to do so, you cannot modify the IP address).
Then enter a new IP address, gateway, and subnet mask. Click OK to save and quit. This function is similar

to [Modify IP Address Function] in Device.
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Modify Communication Password

The system will ask for the old communication password before modifying it. After verification, enter the

new password twice and click OK to alter the communication password.

#

Note: A Password should be a combination of numbers and letters of 6 digits.

Users can modify the fingerprint identification thresholds in the devices; it ranges from 35 to 70, and it is
55 by default. The system will read the thresholds from the device. Users can view the threshold devices

list. More than one device can be changed by using the Batch operation function.

Add a user and a card

Click Personnel Management > Personnel > New.

Personnel ID*
First Name
Gender

Certificate Type

]

New

Department”
Last Name
IMabile Phone

Certificate Number

Department Name

Birthday Email
Device Verification Password Card Mumber .._fu_ =t ‘
Biological Template Quantity go@o g oo -"—-’:; 0 Browse || Capture

- |

Access Control Time Attendance Personnel Detail
Levels Seitings Add Superuser No
+ General Select All e Oy ;
L"sele; Al Device Operation Role Ordinary User

Disabled

SetValid Time

oo oanon | o carcer

Fields are as follows:

Personnel ID: An ID may consist of up to 9 characters, within the range of 1 to 79999999. It can be
configured based on your requirements. The Personnel ID contains only numbers by default but may also
include letters.
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L~ Notes:

When configuring a personnel number, check whether the current device supports the
maximum length and whether letters can be used in Personnel ID.

To edit the settings of the maximum number of characters of each personnel number and
whether letters can also be used, click Personnel > Parameters.

Department: Select from the drop-down menu and click OK. If the department was not set previously,
only one department named Company Name would appear.

First Name/Last Name: The maximum number of characters is 50.

Gender: Set the gender of personnel.

Mobile Phone: Enter the phone number of the user.

Certificate Type: There are four types of certificates: ID, Passport, Driver's License, and others.
Certificate Number: Enter the Certificate number.

Birthday: Enter the employee's Date of Birth.

Email: Enter the employee’s Email ID. The max length is 30 characters.

Device Verification Password: Set the password for verifying with the device using personnel accounts.
It can only contain up to 6-digits. It cannot be the same with other user’s password and the duress
password.

Card number: The max length is 10, and it should not be repeated.

Personal Photo: The picture preview function is provided, supporting common picture formats, such as
JPG, JPEG, BMP, PNG, GIF, etc. The best size is 120x140 pixels.

Browse: Click Browse to select a photo on your local drive to upload.
Capture: Taking a photo by a camera is allowed when the server is connected with a camera.

Register Fingerprint / Finger Vein: Enroll the Personnel Fingerprint, Finger Vein, Palm, or Face. To trigger
the alarm and send the signal to the system, scan the Duress Fingerprint.

How to register fingerprint:
Biological Template Quantity go@og oo

Download Driver
Access Control S — Personnel
Move the cursor to the fingerprint icon position, a registration pop-up or driver download
dialog box will appear, click Register.
Select a fingerprint, press the finger on the sensor continuously until the message
“Fingerprint registered Successfully” is prompted.
Click OK to complete the registration.
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Fingerprint

Fingerprint
- |(_-\| -'r-\.' o -.II
= [ | o~ W
( I|I II |l-' .'I ~ F\\ | ', I 1 |
(. I| [ Y || o Duress Fingerprint o Duress Fingerprint
I b 1
l\ L_J.LJ./ ,.f \\ R\ \_Ah ) S
/ 20
| ) |
) ‘\\\
| WY,
\ AW, \x./' \ / J
o — —_/ _____./ -

Click a fingerprint to delete. If you need to register a duress fingerprint, select the Duress Fingerprint
checkbox.

rl

L~ Notes:

If fingerprints are duplicated, “Don’t repeat the fingerprint entry” will be prompted.

If the fingerprint sensor driver is not installed, click “Install driver” and the system will prompt
to download and install the driver.

After installing the fingerprint sensor driver, if the fingerprint register button is grey in IE
browser while it is normal in other browsers (such as Firefox, Google), you can change the
settings of |IE browser, as per the following:

In Internet Explorer, click Tools > Internet Options > Security > Credible Sites, add
http://localhost to the credible sites, then restart the Internet Explorer.

In Internet Explorer, click Tools > Internet Options > Advanced > Reset to pop up a
dialog of Reset Internet Explorer Settings, click Reset to confirm, then restart the Internet
Explorer (you may try when Point 1 does not help).

If all the above settings do not work, please execute the following operations (take IE11
browser as an example): click Tools > Internet Options > Advanced > Security, check
the option [Allow the software to run or install even if the signature is ...], and remove the
selection of [Check for server certificate revocation], then restart IE.

If the browser version is below IE8, the fingerprint registration page will be different:
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Fingerprint Fingerprint

Scans Left:3

The finger information:
Right Hand

Forefinger

r delete fingerprint

[1+]
5

Click the checkbox to regist

Click the checkbox to register or delete fingerprint. or
I R

The system supports access from the Live20R fingerprint device and the fake fingerprint

prevention function.

The finger information:
Right Hand
Middie Finger

N =

4. To set the Access Control parameters for the personnel, click Access Control.
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Access Control Time Attendance Personnel Detail
Levels Settings Add Superuser No
#| General Select All e O ; "
Unselect Al Device Cperation Role Crdinary User
Disabled
Set Valid Time

T S T

Fields are as follows:

Level Settings: Click Add, then set the passage rules of particular positions in different time zone.

A ba | eeds
Laval Mame | Tima Sona q I:E:
]
| The current query condiions Mone
} Altametive Selecisdil)
L e M Tima Lane Larval Mema Tima dana

0 S0 noras e page T

Superuser: In the access controller operation, a superuser is not restricted by the regulations on time
zones and has extremely high door-opening priority.

Device Operation Role: It will define the authority level in the device of the user.
Disabled: Temporarily disables the personnel’s access level.

Set Valid Time: Doors can be set to open only within specific periods. If the checkbox is not selected, the
door is always open.

]

L— Note: The system will automatically search for the relevant numbers in the departure library during

verification.

The Personnel Information List, by default, is displayed as a table. If Graphic Display is selected, photos
and numbers will be shown. Place the cursor on a photo to view the details about the personnel.
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L~ Notes:

Not all devices support the “Disabled” function. When a user adds a device, the system will

notify the user whether the current device supports this function or not. Please upgrade the

device to use this function.

Not all the devices support the "Set Valid Time” function. Some devices only allow the users to

set the year, month, and day of the local time. When a user adds a device, the system will

notify the user whether the current device supports this function or not. Please upgrade the

device to use this function.

Click Personnel Detail to access the details and editing interface and enter the information.

Access Control
Employee Type
Job Title
Birthplace
Home Phone

Office Phone

Time Attendance

Personnel Detail

v

Hire Type r
Street

Country

Home Address

Office Address

After entering the information, click OK to save and exit, the personal details will be displayed in

the added list.

Access Control Settings

The Access Control system can set the access levels of the registered users, namely, allowing some

personnel to open some doors by verification during a period. Access Control System Management

primarily includes Access Control Time Zones, Access Control Holiday, Door Settings, Access Levels,

Personnel Access Levels, Real-Time Monitoring, and Reports, etc.

Access control system parameters

Page |47

255 time zones.

Unlimited access levels.
Three-holiday types and 96 holidays in total.
Anti-passback function.
Multi-Card Opening function.
Real-time monitoring.

Interlock function.

Linkage function.

First-Card Normal Open function.
Reader Settings.

Auxiliary I/O Settings.

For more details, please refer to “ZKBioAccess User Manual.’

Real-time monitoring

Click Access Device > Real-Time Monitoring.
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It monitors the status and real-time events of doors configured to the access control panels in the system
in real-time, including normal events and abnormal events (including alarm events).

The Real-Time Monitoring interface is shown as follows:

Device blocked - Door Offline

o W

Door sensor not set; relay closed E Door sensor not set; relay opened

Door sensor not set, and the current firmware does not support the current action on the device

Online status Door closed; Relay closed b Online status Door closed; Relay opened

Online status Door closed, and the current firmware does not support the current action on the
device

Online status Door opened; Relay closed L. Online status Door opened; Relay opened

Online status Door opened, and the current firmware does not support the current action on the

device
o
: Door opened alarm; Relay closed . Door opened alarm; Relay opened
o o 0 o
. Door opening timeout, Relay closed . Door opening timeout, Relay opened

Door opening timeout and the current firmware does not support the current action on the

device
1@  Door opening timeout, Relay closed/Door L®  Door opening timeout, Relay opened/
- Sensor Closed = Door Sensor Closed
o
: Door closed alarm; Relay closed 1 Door closed alarm; Relay opened
-

@  Door closed alarm, indicates that the current firmware does not support the current action on the

device
Eﬂ Door sensor not set, Door alarm, Relay ﬁ Door sensor unset, Door alarm, Relay
“  closed “  opened
~®  Door opening timeout, without relay e& Do |edk

status/Door Sensor Closed

Without relay status, it indicates that the current firmware does not support the action on the device.
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Area Status Device Name | Serial Number
Door Auxiliary Input Auxiliary Output
AllDoors || Remote Opening : Remote Closing g Cancel Alarm E Remote Normally Open = More ~

B P

SpeedFace- 192.168.213 192.168.213
V5-1 99-1 .99-2

Current Total:3 @ Online:3 @ Disable:0 @ Offline:0 & Unknown:0 Door Name

Real-Time Events

Time Area Device Event Point Event Description Card Number Personnel Reader Name Verification Mode
2018-12-27 17:48:46  Area Name 192.168.213.99(3633160800001) Device Started Other Other
2018-12-27 17:45:16  Area Name 192.168.213.99(3633160800001) Device Started Other Other
2018-12-27 17:43:24  Area Name 192.168.213.99(3633160800001) Connected to the server Other Other
2018-12-27 17:43:06  Area Name 192.168.213.99(3633160800001) Device Started Other Other
2018-12-27 17:.43.01  Area Name SpeedFace-V5(CGFE184760043) SpeedFace-V5-1 Normal Verify Open 575(Jeff) SpeedFace-V5-1-Out  Face
2018-12-27 17:42:53  Area Name SpeedFace-V5(CGFE184760043) SpeedFace-V5-1 Normal Verify Open 575(Jeff) SpeedFace-V5-1-Out  Face
Total Received: 6 @ Normal:6 o Exception:0 @Alarm:0 Clear Data Rows Event Description L _Shpwf‘hmqs

Different icons represent the status as follows:
Door

Remote Opening/Closing: It can control one door or all the doors.

To control a single door, right-click on it, and click Remote Opening/ Closing in the pop-up window. To
manage all entries, directly click Remote Opening/ Closing in Current All option.

In the remote opening, the user can define the door opening duration (The default is 15s). You can select
[Enable Intraday Passage Mode Time Zone] to enable the intraday door passage mode time zones or
set the door to Normal Open, and then the door will not be limited to any time zones (can be opened at
any time).

To close a door, select [Disable Intraday Passage Mode Time Zone] first, to avoid enabling other normal
open time zones to open the door, and then select [Remote Closing].

#

Note: If [Remote Opening /Closing] fails, check whether the devices are disconnected or not. If

disconnected, check the network connectivity.

Cancel the alarm: Once an alarming door pops-up over the interface, the alarm sound will be played.
Alarm cancellation can be made for a single door and all the entries. To control a single door, move the
cursor over the door icon, a menu will pop-up, then click Remote Opening/ Closing on the menu. To
manage all the doors, directly click Remote Opening/ Closing in Current All option.

Note: If Cancel the alarm fails, check if any devices are disconnected. If found disconnected, check

the network.
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Remote Normally Open: It will set the device as normal open by remote.

Quick Management of Doors

If you move the cursor over a door’s icon, you can quickly perform the above-explained operations.

Besides, you can query the latest events from the door.

E Status

192_’;8_82 Device: 192.168.213.99
Serial Number: 3633160800001
Number: 2
Door Sensor: No Door Sensor
Relay: Close
Alarm: None

Remote Opening

Remote Closing

Cancel Alarm

@0
Remote Normally Open

Enable Intraday Passage Mode Time Zone

Disable Intraday Passage Mode Time Zone

rea Query the latest events from the door 1

Query the latest events from the door: Click to view the current events on the door quickly.

Issue card to a person: If you swap an unregistered card, a record with a card number will pop-up in a
real-time monitoring interface. Right-click that card number, and a menu will pop-out. Click “Issue card to

person,” to assign that card to one person.

Multiple selections

You can select several doors at the same time to perform operations such as remote opening, remote
closing, canceling alarm, etc. Double-click the door icon to edit the door properties.

Area Status | —— Device Name More ®
Door Auxiliary Input Auxiliary Qutput
- 2 — 3 4 - 5 _ 6
All Doors Remote Opening |+ | Remote Closuig @t Cancel Awrm = Remote Nonlally Open = More -
- - - =

1921680 (192168 10| [192.168.10| [192.1681
1051 23241 219-1 76-1

1

Current Total 4 @ Online:0 @ Disable:0 @ Offiine:4 @& Unknown:0 Door Name

Event monitoring

The system will automatically acquire the records of devices being monitored (by default, it displays 200
records), including normal and abnormal access control events (including alarm events). Normal events
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will appear in green; alarm events will appear in red; other abnormal events will appear in orange.

Auxiliary Input

It monitors the current auxiliary input events in real-time.

Area Status 000 e

Door Auxiliary Input Auxiliary Output

Device Name Serial Number

=5 =)
Auxiliary Auxiliary
Input-1 Input-2
Current Total:2 @ Online:0 @ Disable:0 @ Offine:2 @ Unknown:0

Auxiliary Input Name
wn

Real-Time Events

Time Area Device Event Point Event Description Card Number Personnel Reader Name Verification Mode

Auxiliary Output

Here you can perform Remote open, Remote Close, Remote Normally Open functions.

Area

Status ——— Device Name Serial Number
Door Auxiliary Input Auxiliary Output
All Doors Remote Open Remote Close Remote Normally Open
[ [
Auxiliary Auxiliary
Output-1 Output-2
Current Total:2 @ Online:0 @ Disable:0 @ Offline:2 Unknown:0 Auxiliary Output Name
Real-Time Events
Time Area Device Event Point Event Description Card Number Personnel Reader Name

Verification Mode

Reports

Since the data quantity of access control event control is large, you can view the specific access control

events through query conditions. By default, the system displays the last three months' transactions.
Click [Reports] > [All Transactions] to view all the transactions.
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Thetime from | 2018-00-27 00.00.00  Ta 2018-12-27 23:59:50 Personnel 1D E Device Name Moer O ®
The current query conditions The time from:(2018-09-27 00:00:00) To:(2018-12-27 23:59:59)
(% Refresh " Cloar Al Data [ # Export
j HERESEIIT EventiD  Time Device Name Event Point Event Description  Media File Personnel ID First Nama LastName Card Number  Departmen Depe
Number Nam
' Reports

2018-12-27 191548 SpeedFace-Vs Disconnected -
2018-12-27 17:57.30 192.168.213.99 Disconnected

Everts From Today 2018-12-27 175604 192 168 213 99 Device Started
2018-12-27 17:48:46  192.168.213.99 Device Started

Last Known Position
2018-12-27 174516 192 168.213.99 Device Started

SLIEEEEEES 2018-12-2717:4324  102.188.213.99 Connected to the serve

Access Rights By Door 2018-12-27 174306 192 168.213.99 Device Started

Access Rights By Perscnnel 2018-12-27 17:4301 SpeedFace-VS SpeedFace-V5-1 Normal Verify Open 575 Jeff 1 Zr
2018-12-27 17.42.53  SpeedFace-V5 SpeedFace-V5-1 Normal Verify Open 575 Jeff 1 rd
2018-12-27 172529 192 168.213.99 Disconnected
2018-12-27 13:56:46  192.168.213.99 Connected to the serve
2018-12-27 13:56.01 192 168.213.99 Device Started
2018-12-27 11:46:48  SpeedFace-V5 SpeedFace-V5-1 Normal Verfy Open 575 Jeff 1 Zt

Media File: You can view or download the photos and videos.

Clear All Data: This function is used to clear all the transactions. Click [Clear All Data]. In the appearing

pop-up, click OK to remove all the transactions.

Export: You can export all the transactions in Excel, PDF, and CSV format.

All Transactions
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Event Time Device Name| Event Point Event Personnel | First Name | Last Card Depart | Department| Reader | Verification| Area |Rem
1D Description 1D Name | Number ment Name Name Mode Name | ark
Numbe
r
-1 2018-12-27 SpeedFace- Disconnected Other Other Area
19:15:48 V5 Name
1 2018-12-27 ]192.168.213.9 Disconnected Other Other Area
17:57:30 9 Name
64376 | 2018-12-27 [192.168.213.9 Device Started O ther Other Area
17:56:04 9 Name
64375 2018-12-27 ]192.168.213.9 Device Started Other Other Area
17:48:46 9 Name
64374 2018-12-27 |192.168.213.9 Device Started Other Other Area
17:45:16 9 Name
64373 2018-12-27 |[192.168.213.9 Connected to Other Other Area
17:43:24 9 the server Name
64372 2018-12-27 ]192.168.213.9 Device Started Other Other Area
17:43:06 9 Name
1255 2018-12-27 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jeff | ZKTeco | SpeedFace- Face Area
17:43.01 V5 1 Open V5-1-Out Name
1254 2018-12-27 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jeff 1 ZKTeco | SpeedFace- Face Area
17:42:53 V5 1 (O pen V5-1-Out Name
-1 2018-12-27 1192.168.213.9 Disconnected Other Other Area
17:25:29 9 Name
64371 2018-12-27 ]192.168.213.9 Connected to Other Other Area
13:56:46 9 the server Name
64370 2018-12-27 |192.168.213.9 Device Started Other Other Area
13:56:01 9 Name
1253 2018-12-27 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jelf | ZKTeco |SpeedFace- Face Area
11:4R-49 VE 1 Nrnan VE-1-Nant Nama
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Appendix 1

Operating demonstration of connecting C2-260, WR485 and

Wiegand reader

485A
4858

a
=
[a®)
o
'_
GND
] Router +12v

£o)
vee|
+12V +12v GND
GND || +12¥ GND Wiegand DO
4858 ::;; g? Wiegand D1
485A )| assa GLED Green LED
BEEP T
Beeper
X/
WR485 Wiegand reader

Step 2: Power on the C2-260 and connect to the network.

Step 3:Try to ping the C2-260 to check whether the network is good.
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B CAWINDOWS\system32\cmd.exe

te round trip ti
il

1) Press [Windows + R] of the computer at the same time to open the Run window and enter “ecmd”.

2) Enter“ping device IP address” to ping the C2-260 to check whether the communication is

connected. As shown in the figure above.

Step 4: Adding the device on the ZKBioAccess IVS software.

1) Open the ZKBioAccess IVS software, and click Access > Device > Search to enter the Search
interface. Click Search to search the device.
2) After the search is complete, the port number will be displayed on the bottom of the Search

interface. From the following picture we can see server IP (192.168.5.111) and the port
number (8088).

Device Name Serial Number IP Address Morer Q.
The current query conditions None 3
("% Refresh  [% New (fij* Delete Bemngt:onw ~ {6 Setup ~ [Q View/Get ~ & Communication ~

Search
4

Search No device found? Download Search Tools to | ocal Disk

Total Progress | NG | 5<=rch=d devices count 4

IP Address Device Type Serial Number ®
y Input
IP Address MAC Address Subnet Mask Gateway Address Serial Number Device Type Set Server Operations

A 10.10.01 00:17:61:10:1C:DB  255.255.255.0  192.168.5.65 6566151300012  inBIO460 http://192.168.5.112:8088 Add Modify IP Address
10.10.0.2 00:17:61:10:0A:01 2552552550 192.168.5.65 6566151300111 inBIO460 http://10.10.0.3:8088 Add Modify |P Address
192.168.5.231 00:17.61:12:13:85 2552552550 192.168.5.254 6154203000008  NOTUS hitp:/192.168.5.161:808¢ Add Modify IP Address

5

192.168.5.240 00:1761.CA/A324 2552552550 192.168.5.254 6093201400027 C2-260FP http://192.168.5.111:8088 Add Modify |IP Address ]

Port number
A -
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3) Click Add in the search list. Then input the server address (192.168.5.111) , port (8088) and
the other parameters on the pop-up window.

Add

Device Name* [ 192.168.5.240 |

New Server Address” @IP Address  (_)Domain Address
[192 168 5 - 111]

New Server Port™

Communication Password

Icon Type® Door
Area” 2
Add to Level 2
Clear Data in the Device when Adding

A\ [Clear Data in the Device when Adding] will delete data in the device (except event
record), please use with caution|

.

4) Click OK to save the setting. The following window will pop up if the device is successfully added.

Device Name® ‘ 192.168.5.240 |
New Server Address” @IP Addrace  (Namain Addrags
Prompt

New Server Port* The operation succeeded, the device will restart

Communication Pas later.

Area™
Add to Level 2 -]
Clear Data in the Device when Adding

A\ [Clear Data in the Device when Adding] will delete data in the device (except event
record), please use with cautionl

5) After completion, the device added to the software will be displayed in the device list.

Device Name Serial Number IP Address More Q. &®

The current query conditions None

(v Refresh [® New (i Delete [# Export Q Search 2. Control ~ ¢8} Setup ~ [Q View/Get ~ @ Communication ~

Device Name Serial Number ~ AreaName ~ Communicatiol Network 1P Address RS485 Status  Device Register Firmware Version

Connection Parameter Model Device
1/0 Board Mode

Door 192.168.5.240 6093201400027 2 Wired 192.168.5.240 Online  C2-260FP @ AC Ver 9.0.2.0014 Dec 31

Reader

User Manual
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Step 5: Setting the wiegand reader parameters.

1) After adding the C2-260 to the software, click Access > Device > Reader to view the reader.

Reader Name

Door Name

E Device 8 The current query conditions None

[+ Refresh
Device

Reader Name Door Name: Number Communication Communication  In/Out Bound camera Owning Board Operations

Address

110 Board

192.168.5 240-1-In 192.168.5.240-1 1 RS485 1 In 3 Edit Binding/unbinding the camera
Door

192.168.5.240-1-Out 192.168.5.240-1 2 RS485 2 Out Edit Binding/unbinding the camera

e 92 168 5 240-2-1n 192.168.5.240-2 3 RS485 3 In Edit Binding/unbinding the camera

Auxiliary Input 192 168 5 240-2-Out 102.168.5.240-2 4 RS485 4 Out Edit Binding/unbinding the camera

2) Setthe WR485 address as 1. By setting the NO.1 of DIP switch to the ON position. It means that
the wiegand reader which connect through WR485 be set as Door1(In) reader (Note:
Recommended setting the WR485 addresses by the DIP switch before the power supply).

3) Click Edit of the“192.168.5.240-1-In" to set the parameters. Because the WR485 is an encryption
mode, you need to select the encryption check box. So that the Wiegand reader can be used
normally. As shown in the following figure.

Edit
Door Name™ 192.168.5.240-1
Name” 192.168.5.240-1-In
Number® 1
In/Out” In Out
Communication Type® RS3485 w
RS485 Address” I 1 | 1

Encrypt P2 Select the check box

A\ The encryption is copied to all readers in current device!
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Step 6: View the real-time records.

After the setting is successful, when the employee swipes the card on the Wiegand reader, the real-time
event can be viewed on the Real-TimeMonitoring page.

Click Access > Dvice > Real-TimeMonitoring to view the records.

2 1 O & § @ Q wonn -

Area status Devke Name mere~ (%)

E Device Doar Ausiary Input Auxiiiary Qutput

[] Remote Opening [ ] Remele Closing 1y CancelAlam = More ~
Dewice
/O Board E E

192168 § 192188 5
Door 240-1 240-2
Reader
Auxiliary Input
Auxiliary Output
Event Type

light Saving Time
Current Total 2 @ Onine'2 @ Disable’d @ Ofmine0 & LUnknown:'0 Door Name

Device Monitoring

Real-Time Events

e Time Area Device Event Point Event Description Card Numper Person Reader Name VETIMCAtan Mode
Alarm Monitoring 2021-01-12 13.5043 2 92.168.5.240(6093201400027)  192.188.5.240-1 Normal Verify Open 1406105 11y 192.168.5.240-14n  Only Card
Map 3 ]
111)
Normal very Open
2021-01-12 13:50°43
Tetal Received: 1 @ Normal.1 & Exceplion 0 @Alam.0 Clear Data Rows Event Description i
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Appendix 2

Statement on the Right to Privacy

Dear Customers,

Thank you for choosing this hybrid biometric recognition product, which was designed and
manufactured by ZKTeco. As a world-renowned provider of core biometric recognition technologies, we
are constantly developing and researching new products, and strive to follow the privacy laws of each
country in which our products are sold.

We Declare That

All our civilian fingerprint recognition devices capture only characteristics, not fingerprint images, and
do not involve privacy protection.

None of the fingerprint characteristics that we capture can be used to reconstruct an image of the
original fingerprint and do not involve privacy protection.

As the provider of this device, we will assume no direct or indirect responsibility for any consequences
that may result from your use of this device.

If you would like to dispute human rights or privacy issues concerning your use of our product, please
directly contact your dealer.

Our other law-enforcement fingerprint devices or development tools can capture the original images of
citizen's fingerprints. As to whether or not this constitutes an infringement of your rights, please contact
your Government or the final supplier of the device. As the manufacturer of the device, we will assume no
legal liability.

Note:

The Chinese law includes the following provisions on the personal freedom of its citizens:
There shall be no illegal arrest, detention, search, or infringement of persons.
Personal dignity is related to personal freedom and shall not be infringed upon.

A citizen's house may not be infringed upon.

A citizen's right to communication and the confidentiality of that communication is protected by the
law.

As a final point, we would like to further emphasize that biometric recognition is an advanced technology
that will be certainly used in E-commerce, banking, insurance, judicial, and other sectors in the future.
Every year the world is subjected to major losses due to the insecure nature of passwords. The Biometric
products serve to protect your identity in high-security environments.
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Eco-friendly Operation

The product's "eco-friendly operational period" refers to the time period during which this

product will not discharge any toxic or hazardous substances when used in accordance
with the prerequisites in this manual.

The eco-friendly operational period specified for this product does not include batteries or
other components that are easily worn down, and must be periodically replaced. The
battery's eco-friendly operational period is 5 years.

Hazardous or Toxic substances and their quantities

Hazardous/Toxic Substance/Element

Component . Hexavalent | Polybrominate | Polybrominated
Name Mercury | Cadmiu ) ) ]

Lead (Pb) Ha) d) chromium d Biphenyls Diphenyl Ethers

m
J (Cr6+) (PBB) (PBDE)
Chip Resistor X o e o o o
Chip Capacitor X o o o o o
Chip Inductor X [ o o o o
Diode X [ o o o o
ESD
X O O O O O

component
Buzzer X o o e o o
Adapter X o o o o o
Screws o o 0 X o o

o indicates that the total amount of toxic content in all the homogeneous materials is below the
limit as specified in SJ/T 11363—2006.

X indicates that the total amount of toxic content in all the homogeneous materials exceeds the limit
as specified in SJ/T 11363—2006.

Note: 80% of this product’s components are manufactured using non-toxic and eco-friendly
materials. The components which contain toxins or harmful elements are included due to the
current economic or technical limitations which prevent their replacement with non-toxic materials
or elements.
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ZKTeco Industrial Park, No. 32, Industrial Road,
Tangxia Town, Dongguan, China.

Phone : +86 769 - 82109991

Fax : +86 755 - 89602394

www.zkteco.com
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